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HM-4320: Defining Abagus Contacts for 3-D Models in HyperMesh

In this tutorial, you will learn how to:

Load the Abaqus user profile and model
Start the Abaqus Contact Manager
Define surfaces for solid elements
Define surfaces for shell elements
Define surfaces by set

Define surface interaction property

Define contact pair

Model Files

This exercise uses the contactManager 3D tutorial.hm file, which can be found in
<hm.zip>/interfaces/abaqus/. Copy the file(s) from this directory to your working
directory.

Exercise

Step 1: Load the Abaqus user profile and model

A set of standard user profiles is included in the HyperMesh installation. They include:
OptiStruct, Abaqus, Actran, ANSYS, LS-DYNA, MADYMO, Nastran, PAM-CRASH, PERMAS,
and RADIOSS. While the user profiles change the appearance of some panels, they do not
affect the internal behavior of each function.

1.
2.

3.
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Start HyperMesh Desktop.

In the User Profile dialog, set the user profile to Abaqus, Standard 3D.

Open a model file by clicking File > Open > Model from the menu bar, or clicking &
on the Standard toolbar.

In the Open Model dialog, open the abagqus contactManager 3D tutorial.hn file.
The model appears in the graphics area.
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Step 2: Start the Contact Manager

1.

From the menu bar, click Tools > Contact Manager. The Abaqus Contact Manager
opens.

Ty Abagus Contact Manager E@
¥ Gk
Interfﬁce} Surface l Surface Interaction J J d
Interface:
MName « Interface Type Slawve Master  |Surface Interaction | Slawve display|aster display + |
-
DefaultSurfaceColc Auta Maw .. Edit.. Review Delete Fename Sync Close

Steps 3 - 5: Defining Surfaces for Solid Elements

In HyperMesh, you can define the *SURFACE, TYPE=ELEMENT card by using individual
element IDs or sets with corresponding face identifiers. In this exercise, you will create
surfaces by defining individual element IDs and corresponding faces.

Step 3: Create the "box1-top" surface

o v s wWwN =

8.
9.

In the Abaqus Contact Manager, click the Surface tab.
Click New. The Create New Surface dialog opens.

In the Name field, enter box1-top.

Set Type to Element based.

Click the box next to Color and select a color.

Click Create. The Element Based Surface dialog opens, from which you can define
elements and corresponding faces for the surface.

In the Model browser, Component folder, right-click on BOX_1 and select Isolate
from the context menu.

On the Standard Views toolbar, click 1—5 (XY Top Plane View).

In the Element Based Surface dialog, click the Define tab.

10. Set Define surface for to 3D solid, gasket.
11. Click Elements.

12. In the panel area, click elems >> by collector.

4 | -
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13.
14.

15.
16.
17.
18.
19.
20.

21.
22.
23.

24,

25.

26.

Select the component, BOX_1.
Click select. The elements in the BOX_1 component highlight.

Click proceed to return to the Element Based Surface dialog.

Set Select faces by to Solid skin.

Select a color from the Solid skin color button.

Click Faces. HyperMesh creates a temporary skin of the selected elements.
Select an element from the top of the solid skin.

In the panel area, click elems >> by face. All faces at the top of the solid skin
highlight.

Rotate the model to verify all desired faces are selected.
Optional. Deselect any element by right-clicking or add more if you like.

When you are satisfied with the element faces selected, click proceed to return to the
Element Based Surface dialog.

Click Add to add these faces to the current surface. HyperMesh creates special face
elements (rectangles with dot in the middle) for display.

Optional. Reject the recently added faces by clicking Reject. You can also delete faces
from the Delete page.

When satisfied with the surface definition, click Close to return to the Abaqus Contact
Manager.
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-y Abaqus Contact Manager E@
v vy
Interface 1 Surfﬁcel Surface Interaction J J ﬂ
Surface:
Name Type Display Display Al |
boxl-tap Surface Elemant ~ I
Display None |
Display Reverse |
Draw Rigid Surfaces |
-
DefaultSurfaceColc Auto | [R=3 ‘ Edit... ‘ Feview Delete Rename Sync ‘ Close |

Step 4: Create the "box2-top" surface

NS v A=

10.
11.
12.
13.
14.
15.
16.
17.
18.
19.

In the Abaqus Contact Manager, click the Surface tab.

Click Display None to turn off the display of all surfaces.

Click New. The Create New Surface dialog opens.

In the Name field, enter box2-top.
Set Type to Element based.

Click the box next to Color and select a color.

Click Create. The Element Based Surface dialog opens, from which you can define

elements and corresponding faces for the surface.

In the Model browser, Component folder, right-click on BOX_2 and select Isolate

from the context menu.

On the Standard Views toolbar, click tf (XY Top Plane View).

In the Element Based Surface dialog, click the Define tab.

Set Define surface for to 3D solid, gasket.
Click Elements.

In the panel area, click elems >> by collector.
Select the component, BOX_2.

Click select. The elements in the BOX_2 component highlight.

Click proceed to return to the Element Based Surface dialog.

Set Select faces by to Nodes on face.
Click Nodes.

Select two corner nodes (or three nodes) from the top of the selected solids as shown

below.
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20. In the panel area, click proceed to return to the Element Based Surface dialog.
21. In the Break Angle field, enter 30.00.

22. Click Add to find all of the faces of the selected solids that fall within the break angle of
the face defined by nodes. HyperMesh adds these faces to the current surface and
creates special face elements (rectangles with dot at the middle) for display.

23. Optional. Reject the recently added faces by clicking Reject. You can also delete faces
from the Delete page.

24. When satisfied with the surface definition, click Close to return to the Abaqus Contact

Manager.
"\ Abagus Contact Manager EI-'
(k)
Interface l Surface l Surface Interaction EI ﬂ *_E‘I
Surface:
Name Type Displa: - Display Al |
baxl-top Surace Element - o
box24op Surface Element ~ M Display Mone |
| Display Reverse |
Draw Rigid Surfaces |
-
El :
DefaultSurfaceColc Auto MNew .. Edit... Resview Delete Rename | Sync | Close |
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Step 5: Create the "cylinder-top" surface

1
2
3
4.
5
6
7

10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.

21,
22.
23.

24,

25.

In the Abaqus Contact Manager, click the Surface tab.
Click Display None to undisplay all surfaces.

Click New. The Create New Surface dialog opens.

In the Name field, enter cylinder-top.

Set Type to Element based.

Click the Color button and select a color.

Click Create. The Element Based Surface dialog opens, from which you can define
elements and corresponding faces for the surface.

In the Model browser, Component folder, right-click on TOP_CYLINDER and select
Isolate from the context menu.

In the Element Based Surface dialog, click the Define tab.

Set Define surface for to 3D solid, gasket.

Click Elements.

In the panel area, click elems >> by collector.

Select the component, TOP_CYLINDER.

Click select. The elements in the TOP_CYLINDER component highlight.
Click proceed to return to the Element Based Surface dialog.

Set Select faces by to Solid skin.

Select a color from the Solid skin color button.

Click Faces. HyperMesh creates temporary skin of the selected elements.
Select an element from the solid skin.

In the panel area, click elems >> by face. The faces all around the solid skin
highlight.

Rotate the model to verify all desired faces are selected.
Optional. Deselect any element by right-clicking, or add more if you like.

When you are satisfied with the element faces selected, click proceed to return to the
Element Based Surface dialog.

Click Add to add these faces to the current surface. HyperMesh creates special face
elements (rectangles with dot at the middle) for display.
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Optional. Reject the recently added faces by clicking Reject. You can also delete faces
from the Delete page.
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26. When satisfied with the surface definition, click Close to return to the Abaqus Contact

Manager.
-y Abagus Contact Manager E@
v ] %
Interface 1 Surface l Surface Interaction J J J
Surface:
Narme Type Display | | Display Al |
baxl-tap Surface Elemant r
hox2-top Surface Element r 3 Display None |
cylindertop Surface Element v _|
— Dizplay Reverse |
Draw Rigid Surfaces |
hd
DefaultSurfaceColc Auta | Maw .. ‘ Edit... ‘ Review Delete Fename Sync ‘ Close |

Step 6: Define surfaces for shell elements

In HyperMesh, you can define the *SURFACE, TYPE=ELEMENT card by using individual shell
element IDs or sets with corresponding SPOS/SNEG face identifiers. In this exercise, you
will create surfaces by defining individual element IDs and corresponding normals to define
the SPOS/SNEG faces.

Complete the steps below to create the "cylinder-bot" surface:

N v A=

10.

11.
12.
13.
14.
15.

In the Abaqus Contact Manager, click the Surface tab.
Click Display None to undisplay all surfaces.

Click New. The Create New Surface dialog opens.

In the Name field, enter cylinder-bot.

Set Type to Element based.

Click the Color button and select a color.

Click Create. The Element Based Surface dialog opens, from which you can define
elements and corresponding faces for the surface.

Click the Define tab.
Set Define surface for to 3D shell, membrane, rigid.

In the Model browser, Component folder, right-click on BOT_CYLINDER and select
Isolate from the context menu.

In the Element Based Surface dialog, click Elements.

In the panel area, click elems >> by collector.

Select the component, BOT_CYLINDER.

Click select. The elements in the BOT_CYLINDER component highlight.
Click proceed.

4 | -
Proprietary Information of Altair Engineering \ A ta I r



Altair HyperMesh 2019 Tutorials p.8

16. The normals of the selected elements will be displayed at this point. If the normals are
too big, click Iﬂ (YZ Front Plane View) on the Standard Views toolbar.
Notice that all normals are pointing inwards.

17. Check the Reverse option.

18. Click Add to add these faces to the current surface. HyperMesh creates special face
elements (rectangles with dot at the middle) for display.

19. Optional. Reject the recently added faces by clicking Reject. You can also delete faces
from the Delete page.

20. Click the Adjust Normal tab.
21. Click Display normals. The normals of all the faces in the current surface display.
Notice that all normals are pointing outwards.

22. When satisfied with the surface definition, click Close to return to the Abaqus Contact
Manager.

& | -
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-y Abaqus Contact Manager E@
v vy
Interface 1 Surfﬁcel Surface Interaction J J ﬂ
Surface:
Name Type Display | + | Display Al |
boxl-tap Surface Elemant r o
hox2-top Surface Element r . Display None |
cylindertop Surface Element r -
oylinder-bot Surace Element ~ Display Reverse |
Draw Rigid Surfaces |
-
DefaultSurfaceColc Auto | [R=3 ‘ Edit... ‘ Feview ‘ Delete ‘ Rename Sync ‘ Close |

Steps 7 - 8: Define Surfaces by Set

In HyperMesh, you can define the *SURFACE, TYPE=ELEMENT card by using individual
element IDs or sets with corresponding face identifiers. In this exercise, you will create
surfaces by defining a set and corresponding face identifiers. HyperMesh allows only one set
in a surface. It also does not support a combination of sets and individual elements in the
same *SURFACE data line.

Step 7: Create the box1-bot surface

NS u A=

10.

11.
12.
13.
14,
15.

In the Abaqus Contact Manager, click the Surface tab.
Click Display None to undisplay all surfaces.

Click New. The Create New Surface dialog opens.

In the Name field, enter box1-bot.

Set Type to Element based.

Click the Color button and select a color.

Click Create. The Element Based Surface dialog opens, from which you can define

elements and corresponding faces for the surface.
Click the Define tab.
Set Define surface for to Element set.

In the Model browser, Component folder, right-click on BOX_1 and select Isolate

from the context menu.

—

On the Standard Views toolbar, click b (YX Bottom Plane View).
In the Element Based Surface dialog, set Element set to box1-bot.
Click Review Set to highlight all of the elements in the selected set.

Right-click on Review Set to reset the highlighting.

Click Show Faces. HyperMesh creates a temporary skin of the selected element set.

Proprietary Information of Altair Engineering
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16.
17.

18.
19.

20.
21.

22.

Select an element from the bottom of the solid skin.

In the panel area, click elems >> by face. All of the faces on the bottom of the solid
skin highlight.

Optional. Deselect any element by right-clicking, or add more if you like.

When you are satisfied with the element faces selected, click proceed to return to the
Element Based Surface dialog.

At this point, the face identifier tags (color coded) of the selected faces are displayed.
In performance graphics, the solid mesh sometimes blocks these tags. You might have
to rotate the model a little to make these tags visible or switch to Standard graphics.

Click the right arrow key to move the box1-bot set into the table.
In the table, click on the Face pull down menu and select S3.

Note: Because all of the face identifier tags for the bottom side of the box1-bot set
are S3, you can use the S3 identifier for this set.

Select the Display checkbox, and then click Update. HyperMesh adds the selected set
and face identifier to the current surface. In addition, it creates a special display for the
surface.

By default, HyperMesh does not create a display for surfaces defined with sets.
However, if you select the Display checkbox before clicking Update, it will create a
special display using contactsurface elements. The special display does not have any
link to the set in the HyperMesh database. Therefore, if you edit the set later on, the
display will not reflect them automatically. In this case, you need to come to this page,
select the Display checkbox and click Update again.

23. Click Close to return to the Abaqus Contact Manager.

*, Abaqus Contact Manager EI@
=y
Interface ] Surface] Surface Interaction l @ ﬂ ﬁ
Surace:
Name Type Displa -~ Display Al |
baxl-top Surface Element r o
hoxZ-top Surface Element I~ - Dizplay None |
cylindertop Surface Element r _| |
cylinderhot Surface Element r Display Revarse |
hox1-bot Surface El t
il Uriace = emen il | Draw Rigid Surfaces |
-
| E
DefaultSurfaceColc Auta MNew Edit Revigw: Delete Fename | Sync | Close |

4 | :
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Step 8: Create the box2-bot surface
In the Abaqus Contact Manager, click the Surface tab.
Click Display None to undisplay all surfaces.

Click New. The Create New Surface dialog opens.

1
2
3
4. In the Name field, enter box2-bot.
5. Set Type to Element based.

6. Click the Color button and select a color.
7

Click Create. The Element Based Surface dialog opens, from which you can define
elements and corresponding faces for the surface.

Click the Define tab.
Set Define surface for to Element set.

10. In the Model browser, Component folder, right-click on BOX_2 and select Isolate
from the context menu.

—

11. On the Standard Views toolbar, click {+* (YX Bottom Plane View).
12. In the Element Based Surface dialog, click Create/Edit Sets.

13. In the panel area, enter box2-bot in the name field.

14. Click elems >> by collector.

15. Select the component, BOX_2.

16. Click select.

17. Click create.

name = |box2-bot
- | card image | update
seftype: - non-ordered | card edit

entity: hd elermns m

[ formula

18. When you are done creating/editing the set, click return.

19. Set Element set to box2-bot.

20. Click Review Set to highlight all of the elements in the selected set.

21. Right-click on Review Set to reset the highlighting.

22. Click Show Faces. HyperMesh creates a temporary skin of the selected element set.
23. Select an element from the bottom of the solid skin.

24. In the panel area, click elems >> by face. All of the faces on the bottom of the solid
skin highlight.

25. Optional. Deselect any element by right-clicking, or add more if you like.

4 | -
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26. When you are satisfied with the element faces selected, click proceed to return to the

27.
28.

29.

30.

31.
32.

33.

Element Based Surface dialog.

At this point, the face identifier tags (color coded) of the selected faces display. In
performance graphics, the solid mesh sometimes blocks these tags. You might have to
rotate the model a little to make these tags visible or switch to standard graphics.

Click the right arrow to move the box2-bot set into the table.
In the table, click on the Face pull down menu and select S3.

Note: Because all of the face identifiers tags for the bottom side of the box2-bot set
are 83, you can use the S3 identifier for this set.

Clear the Display checkbox if it is selected, then click Update to add the selected set
and face identifier to the current surface.

Note: By default, HyperMesh does not create any display for surfaces defined with
sets.

Click Close to return to the Abaqus Contact Manager.

Note: Notice in the Surface table that the Display option for the box2-bot surface

is disabled.
At this point, you have created all of the required surfaces.
"\ Abagus Contact Manager E@
@ @ %
Interface 1 Surface] Surface Interaction J J ﬂ
Surface:
Name Type Display | + Display Al |
haoxl-top Surface Element r
hox-top Surface Element r 3 Dizplay None |
cylindertop Surface Elerment r .
cylindar-hot Surface Elemant r B Display Reverse |
hox1-bat Surface Element r A .
Draw Rigid Sur |
hiox2-hot Surface Element F rewrIgIc SUnaces
B
DefaultSurfaceColc Auto [RT=N Edit... Rewview Delete ‘ Rename ‘ Sync ‘ Close |

Click Display All to display all surfaces.

In the Model browser, right-click on the Components folder and select Show from the
context menu. All of the components display.

On the Standard Views toolbar, click $ (Isometric).

4 | -
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34. Review a surface by selecting it from the table and clicking Review. Selected surfaces
will be highlighted in red, while the rest of the model displays in gray. If the surface is
defined with sets (display option disabled), the underlying elements are highlighted.
Right-click on Review to clear the highlighting.

Step 9: Define the surface interaction property

In this exercise, you will define the *SURFACE INTERACTION card with a corresponding
*FRICTION card.

Complete the steps below to create the "friction1" surface interaction.

In the Abaqus Contact Manager, click the Surface Interaction tab.
Click New. The Create New Surface Interaction dialog opens.

In the Name field, enter frictionl.

Click Create. The Surface Interaction dialog opens.

Click the Define tab.

Under Select mechanical interaction properties, select Friction. The Friction tab
becomes active.

Click the Friction tab.
Set Friction type to Default.

o s e

In the second pane, select Direct.

4 | :
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Note: Selecting this option means that the exponential decay and Anisotropic

parameters will not be written to the input file.

10. In the No of data lines field, enter 1. A single row appears in the Direct table.

11. In the Friction Coeff column, click the first cell and enter 0.05.

For Direct and Anisotropic tables:

Change the number of columns in the table by specifying a value in the No of
Dependencies field; change the number of rows in the table by specifying a value
in the No of data lines field.

Enter values in the table by clicking a cell to make it active and then typing in
values. The table works like a regular spreadsheet.

Read comma-delimited data from a text file by clicking Read From a File. In the
file browser, select a file and click Open to export the comma-delimited data. The
row number will be set to the number of data lines found in the file.

Access copy, cut, and paste options by right-click in the table. Comma-separated
data can be copied/cut into or pasted from clipboard with these options. Relevant
hot keys (for example, Ctrl-C, Ctrl-X and Ctrl-V in Windows) will also work.

Activate cells by left-clicking in a cell. Clicking into an already active cell moves the
insertion cursor to the character nearest the mouse.

Highlight cells by left-clicking while moving the mouse over a cell.
Move the active cell using the left, right, up, and down arrows.
Extend the selection in a specific direction using SHIFT-<arrow>.

Move the insertion cursor within a cell using CTRL-left arrow and CTRL -right
arrow.

Selects all cells using CTRL -slash.

Delete the character before the insertion cursor in the active cell using BACKSPACE.
If multiple cells are selected, BACKSPACE deletes all selected cells.

Remove the character after the insertion cursor in the active cell using DELETE. If
multiple cells are selected, DELETE removes all selected cells.

Move the insertion cursor to the beginning of the active cell using CTRL-A. Move the
insertion cursor to the end of the active cell using CTRL-E.

Decrease and increase the width of the column with the active cell in it using CTRL-
minus (-) and CTRL-equal (=).

Interactively resize a row or column by left-clicking or right-clicking on a border
while moving the mouse.

11. Click OK to return to the Abaqus Contact Manager.
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Steps 10-13: Define the Contact Pairs

In this exercise, you will define the *CONTACT PAIR card with corresponding surfaces and
surface interaction.

Step 10: Create the top-cylinder-box1 contact pair
In the Abaqus Contact Manager, click the Interface tab.
Click New. The Create New Interface dialog opens.

In the Name field, enter top-cylinder-box1.

Set Type to Contact pair.

Click Create. The Contact Pair dialog opens.

Click the Define tab.

Set Surface to box1-top.

Click Slave>> to identify box1-top as the slave surface and move it into the table.

© ® N O U A WN =

Click Review. The selected surface highlights red. If the surface is defined with sets
(display option disabled), the underlying elements highlight. Right-click on Review to
clear the highlighting.

Clicking New opens the Create New Surface dialog, from which you can create a new
surface. When you are done creating and defining the surface, the Contact Pair dialog
returns with the new surface selected as the slave surface.

7y Altair
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10. Repeat steps 10.7 and 10.8, selecting cylinder-top and clicking Master>> to identify
it as the master surface.
Note: To more clearly see the surfaces available for selection, click J . This opens
an enhanced browser where you can easily search for the appropriate item.
You can also click Filter to filter the items displayed.
Set Interaction to frictionl1.
Note: To more clearly see the interactions available for selection, click J . This
opens an enhanced browser where you can easily search for the appropriate
item. You can also click Filter to filter the items displayed.
Click the Parameter tab.
Select the Small sliding checkbox.
Click OK to return to the Abaqus Contact Manager.
*v Abagus Contact Manager o || =] E3
Interfﬁl:ew Surface l Surface Interaction j J ﬂ
Interface:
MName ~ Interface Type Slave Master  |Sudface Interaction |Slave display|vaster display « |
toprcylinder-hox] Contact Pair hoxl-top | cylindertop friction? ~ I ¥
Kl 0
DefaultSurfaceColc Auta | Maw .. ‘ Edit... ‘ Review ‘ Delete ‘ Fename Sync Close

Step 11: Create the top-cylinder-box2 contact pair

Follow step 10.1 through 10.14 above to define the top-cylinder-box2 contact pair with
box2-top as slave surface, cylinder-top as master and friction1 as the surface
interaction.

Step 12: Create the bot-cylinder-box1 contact pair

Follow step 10.1 through 10.14 above to define the bot-cylinder-box1 contact pair with
box1-bot as slave surface, cylinder-bot as master and friction1 as the surface
interaction.

Step 13: Create the bot-cylinder-box2 contact pair

Follow steps 10.1 through 10.14 above to define the bot-cylinder-box2 contact pair with
box2-bot as slave surface, cylinder-bot as master and friction1 as the surface
interaction.

Proprietary Information of Altair Engineering
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At this point, you have created all of the contact pairs required. Review any contact pair by
selecting it from the table and clicking Review. Both the master and slave surface highlight
in red while the rest of the model is grey. If a surface is defined with sets (display option
disabled), the underlying elements highlight. Right-click on Review to clear the
highlighting.

Click Close to close the Abaqus Contact Manager.

General comments:

Click Edit to open the dialog for editing the selected interface, surface, or surface
interaction

Click Delete to remove the selected interfaces, surfaces, or surface interactions.
Multiple selections can be removed from the Interface table at once.

Click Sync to update the Contact Manager with the current HyperMesh database. If
you create, update, or delete any components, groups, properties, or entity sets
from HyperMesh panels while the Contact Manager is open, click Sync to update
the Contact Manager.

If you minimize the Contact Manager dialog or if it goes behind HyperMesh, click
Tools > Contact Manager to restore it.

Bubble help exists for important buttons. Place the mouse on the buttons for a few
moments to view it.

Double-click on interface, surface, and surface interaction names in the table to open
the corresponding edit dialog. Right-click on these names to display a pull down
menu with options.

Left-click or right-click on a table border while moving the mouse can resize columns
in a table.

SHIFT and CTRL keys can be used while left-clicking to select multiple items in a
table (useful for deleting multiple items).

4 | -
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